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Downloading Exercise Files

Exercise files can be downloaded from the Cheryl Price web site as follows:

1 In your web browser, type: www.cherylprice.co.nz

2 Press Enter on the keyboard to display the Cheryl Price website.

Click in the Product Search box and type the number of this unit

. 112
3 | standard, as shown at the right. us

4 Click on

5 Clickon US112

Under the Exercise Files heading click on the underlined blue hyperlink, ie
6 Book Exercise Files - V6 Word 2010 Free Download
The File Download dialog box will display.

7 If you have Winzip use the following instructions otherwise move to step 8.

a Click on )

T
b
b Clickonthe =~ ofthe e button.

¢ If My Documents folder is not displayed click on Set default unzip folder at the bottom of
the list. Ensure My Documents is selected then click on Select Folder.

Tk

d Clickonthe - ofthe - button and click on the My Documents folder. The files will
be unzipped.

8 Click on and ensure My Documents folder is displayed.

Click on Open Folder which will display My Documents folder. Right click on the zipped
9 exercise file and select Extract All. Click on Extract. A folder will be created containing the
exercise files.

Note The exercise files for this book will be stored by default into a folder called 112 Exercise
Files W2010 in the My Documents folder displayed in the Documents Library.
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Unit Standard 112 Version 6

Produce business or organisational information using
word processing functions

Level 3 Credits 5

Purpose People credited with this unit standard are able to: apply word
processing features and functions to produce business or
organisational information; and apply file management and
printing techniques to manage document production.

Classification Business Administration > Business Information Processing

Available grade Achieved

Entry information

Recommended skills Unit 111, Use a word processor to produce documents for a
and knowledge business or organisation

Explanatory notes

1  All activities associated with this unit standard must comply with occupational
health and safety guidelines and recommendations in relation to working
environment and work practices. Reference for this unit standard includes OSH
3211 AFC: 1996 Approved Code of Practice for the use of Visual Display Units
in the Place Of Work. Occupational Safety and Health Service: Department of
Labour, available at http://www.osh.govt.nz/order/catalogue/pdf/vdu-ac.pdf.

2 Logical structures such as folders must be used to organise and store files
according to business or organisational requirements.

3 Business or organisational information requires the production of six different
types of documents which may include but are not limited to — legal, financial
and technical documents; formal reports; formal meeting documents;
promotional brochures; forms for completing electronically and/or manually.

4 Spelling, grammar, vocabulary, and punctuation in the documents must be
consistent with the nature and purpose of the business or organisational
information required. Candidates must be given the opportunity to proofread their
work prior to submission.
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Outcomes and evidence requirements

Outcome 1

Apply word processing features and functions to produce business or organisational
information.

Evidence requirements

1.1 Display and formatting features are applied to present documents in
accordance with the output required and organisational style requirements.
Range features include but are not limited to — page numbering

options, page and section breaks, page layout, header and
footer features, font selection and size, text format, use of
lines, boxes, borders, alignment, columns including
hyphenation, bullets and numbering.

1.2 A template is used and variable data is inserted in accordance with the
output required.

1.3 A mail merge is created in accordance with the output required.

14 Sorting options are applied in accordance with the output required.

15 Tables are produced incorporating multiple line headings, ruled and non-
ruled columns, and a range of column widths in accordance with the output
required.

Outcome 2

Apply file management and printing techniques to manage document production.

Evidence requirements

2.1

2.2

2.3

Access to word processing files is controlled through the implementation of
file management system procedures.

Range password protection, login procedures, document storage, and
file back up and/or copying procedures;
evidence of three procedures is required.

The creation of folders and movement between them are consistent with file
management system procedures.

File types are differentiated in accordance with file management system
procedures.

Range document, template.

viii



2.4 Print options are identified and used in accordance with system features and
output required.

Range may include but are not limited to — selected text, single page,
multiple pages, entire document, print preview, duplex printing;
evidence of three is required.

2.5 Printer capability and settings are identified and, where available, an
alternative printer is selected.

2.6 Paper loading and print cartridge changing operations are carried out in
accordance with equipment guidelines and organisational requirements.

Files used in this book

Achieving Consistency

Merge-Data

Adelaide Shopping

Merge-Main

Banking Motor Homes
Beads, Seeds and Shells Mouse
Beauty Care Numbering

Book Sales

Numbering Exercise

Cairns

Paris in the late 19" Century

Care of a New Puppy

Planning a Wedding

Caring for your Carpet

Proofreading-test

Cashflow

Rafting

Choosing a Cat

Send-a-Basket-test

Costello Show Jumping
Departments Sort List

Dining Out Sorting Assessment
Email List Sorting Exercises
Formats-test Suncare

Good Food News Tables-test
Healthcare Insurance Toastmasters

Holland Sightseeing

Toastmasters Flyer

Italy Tour and Event
Jury Service Triathlon
Managing a Mortgage Xmas Gifts

Mclvers




File Management
Bullets and Numbering,

1 Hyphenation
Pagination

Section

Learning Outcomes

At the end of this section you should be able to -

Q

Q

Create, use and delete folders

Copy, move, rename and delete files

Differentiate between program and document files

Use bullets and numbering options

Insert hyphens automatically and manually

Use pagination options

© Cherylprice.co.nz Limited

SECTION 1
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File Management

Folders

In any program it is useful to set up folders so that work can be filed in separate sections - similar
to putting documents relating to different projects in separate drawers in a filing cabinet.
(Subfolders can be created below folders.)

The hard disk is called C Drive which in computer language is written as C:\ (also called the Root
or Main folder). (If you are on a network you may be on F Drive or G Drive or on another drive.)

The Word 2010 program files are in a subfolder called Officel4 (off the Program Files \Microsoft
Office folder). Some program files have file extensions such as .exe, .dll, .cnv, etc. (The file type
can be seen by right clicking on a file and choosing Properties.)

Your documents are usually saved in a folder called My Documents. The general structure of
Windows 7 is displayed below. A folder called 112 Exercise Files W2010 has been placed in the
My Documents folder. This folder contains all the exercise files you will use in this book.

You will create the folder called Exercise Files 1onl later in this section. (If you are working on
another drive and using another folder you will need to substitute these in this section for C Drive
and My Documents.)

'® Computer I

[ ’
= Local Disk (C:)

Program Files

L

Microsoft Office

Media

Most of the Word 2010
- OFfiCELY wwereererrerensesean: program files are
located in this folder.

— Templates.., Sample templates of
......... different document types.
....... Templates you create are

————— " Users stored in your Users

profile folder.
|— Your Name

Your documents are

My Documents ™" stored here.

I 112 Exercise Files W2010

Exercise Files 1onl

I My Pictures

Windows

L cDDrive D)

Note If you are logging onto a network to use a computer the Users folder will be stored on a
network server not on the local disk drive.

2 SECTION1 © Cherylprice.co.nz Limited



Path Names

A path name refers to the location of a file/or files. A backslash (\) is used between folder names
to clearly identify each folder. An example of a path name would be the location of the Templates
folder on your computer — c:\Program Files\Microsoft Office\Templates. In Windows Explorer or
your Open/Save As dialog box you would double click on your C drive, then double click on
Program Files folder, double click on the Microsoft Office folder then on the Templates folder.

Templates created by you are stored in your own user profile folder at this location -

C:\Users\Your Name\AppData\Roaming\Microsoft\Templates

The Open Dialog Box

Click on the *
This will display all Word

next to

Exercise 1
1  Start Microsoft Word 2010.
- =
2 Click on and click on = 9%
3 Click onthe " nextto =) Decuments ynder Libraries in the Navigation pane at the left. A list
of folders displayed in the Documents library will appear.
°| My Documents . Double click on ¢ 112 Exercise Files W2010
documents in the 112 Exercise Files W2010 folder.
4  Click on the More Options ~ from the Change your view button = ~

dialog box and select == Details

at the top of the

@ Open
@n\:)v| . ¥ Libraries » Documents » My Documents » 112 Exercise Files W2010 - |¢'v, | ‘ Search 11
e e 2 -
Organize = ew folder .
Address bar - A — — More Options
displaysthe  —T| Documents library A )
4.0 Favorites e Eilec U Anancely
current folder 3 112 Exercise Files W2010 N Change your
B Desktop N Dote modified — - . .|| view button
4 Downloads ame ate modified ype ize
il Recent Places @ Achieving Consistency 23/01/2011 4:27 p.... Microsoft Wor 36K
= @ Adelaide Shopping 23/01/2011 4:26 p....  Microsoft Wor 15 KH
4 | o Libraries 5] Banking 23/01/2011 4:35 p....  Microsoft Wor 15KH
a 3 Docurments | @ Beads, Seeds and Shells 23/01/2011 425 p....  Microsoft W 15Kl
» 1 Public Documents & Beauty Care 23/01/2011 4:24 p....  Microsoft Wor 15Kt
4 2 My Documents = @) Book Sales 23/01/2011 4:24 p....  Microsoft Wor 14 Kt List of files
A . 112 Exercise Files W. 1 Cairns 23/01/201T FE p—hi ft o
Navigation ¥ e o ) - stored within
» 1 ASUS WebStorage & Care of a Mew Puppy 23/01/2011 4:23 p....  Microsoft Wor = :
pane the active
My Data Sources ] Caring for your Carpet 23/01/2011 4:22 p....  Microsoft Wor folder
* ¢t My Dropbox 1] Cashflow 23/01/2011 4:21 p....  Microsoft Wor
. Qutlock Files & Choosing a Cat 23/01/2011 21 p.... Microsoft W
> =l My Pictures @ Costello 23/01/2011 4:30 p....  Microsoft Wor
» |1 Public Pictures & Departments 23/01/2011 4:20 p....  Microsoft Wor
> o) Music - 4 1 k
File name: - [AII Word Documents '] T f fil
g ype ot Tiles
Tools ~ l Open |v] ’ Cancel ] d|sp|ayed
The dialog box displays:

e  The name of the active folder - currently 112 Exercise Files W2010.
e  Alist of files stored within the 112 Exercise Files W2010 folder.
e  The type of files currently selected, ie All Word Documents.

© Cherylprice.co.nz Limited
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5 Position the mouse pointer on the title bar of the Open dialog box and double click. This will
expand the dialog box to full screen. With the dialog box shown at full screen you can see all
items listed in the Navigation Pane.

Tip  The Open and Save As dialog boxes can be resized by placing the mouse pointer at the edge
of the dialog box; when the double arrow appears click and drag to resize.

Navigation Pane

The Navigation Pane at the left of the Open and Save As dialog boxes helps you to move around
your computer. Look at the options described below.

; @ Microsoft Word

4.7 Favorites
Bl Desktop
4 Downloads

| Recent Places

4 = Libraries
4 |°¢ Documents
Public Documents
4 | 1) My Documents
112 Exercise Files W20
ASUS WebStorage
My Data Sources
*@id My Dropbox
Outlook Files
+ | =] My Pictures
Public Pictures
; .. Music
* =] Pictures

> E Videos
; f-& Homegroup
48 Computer
&, 05 (C)
- s DATA (D:)
a E'.l_i Metwaork
Managing Files

Exercise 2

1 Double click on the title bar of the Open dialog box to return it to its normal size.

2  Use the Change your view button
the right and how these options change the display of your files.

3  Change the view back to Details.

4 SECTION1

Microsoft Word — A shortcut to the Templates folder

Favorites — Shortcut links to favourite locations.
Desktop — Displays a list of files, folders, etc on the Desktop
Downloads — Displays a list of files downloaded from the Internet
Recent Places — Displays a list of folders and files previously used
Libraries — Libraries are a new concept introduced with Windows 7.

Libraries, however are not actual storage locations. Rather, they display
the contents of other folders, grouping similar files together.

Documents — Displays the contents of the My Documents folder
on the hard disk drive and other document folders assigned to the
Documents library

Music — Displays the contents of the My Music folder and other
folders containing music assigned to the Music library

Pictures — Displays the contents of the My Pictures folder and
other folders containing pictures assigned to the Pictures library

Videos — Displays the contents of the My Videos folder and other
folders containing videos assigned to the Videos library

Homegroup — Allows you to share files and printers across a home
network.

Computer — Displays your hard drive(s), CD/DVD drive and any other
external drives (USB devices, etc).

Network — Displays a list of drives and folders that can be accessed
from a server.

K| Extra Large Icons

| Largelcons

afa Mediurn Icons

Small Icons

S List

4= Details

0

~ 7 to look at each of the options shown at

o -
G- Tiles

HE Content
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Ctrl C,
Ctrl Vto
paste

Ctrl X,
Ctrl Vto
paste

F2

Exercises that relate to the following notes are included on page 8.

Selecting Files

One File Click on the file.

Random Files Click on the first file. Hold down the Ctrl key and click on other files. (You
can click again on a file to deselect it.)

Sequential Files  Click on the first file. Hold down the Shift key and click on the last file to be
selected. All files between these two files will be selected.

Selected files can then be -
Deleted - by pressing the Delete key.

Copied - by right clicking and selecting Copy. You can then change folders and select the folder
you want to copy the files to. Right click on a blank area in that folder and select Paste. (If you
are copying to a CD/DVD or USB Drive you can select the Send to option from the shortcut menu,
instead of Copy.)

Moved - by right clicking and selecting Cut. You can then change folders and select the folder
you are moving the files to. Right click on a blank area and select Paste.

Printed - by right clicking and selecting Print.

Tip Organize v

You can also use the button to delete, copy and move selected files.

Renaming Files

1 In the Open dialog box right click on the file and select Rename. The name will be selected,

oq 2
2  Type a new name for the document, eg Restaurants then press Enter.

Alterntively, click twice in the file name, type the new name and press Enter.

Saving Files in a Different Format

Word files can be saved in a different format, eg as a text file, template, Web Page, PDF, in Rich
Text Format (for exporting to other programs), etc.

1 With the file open, click on then click on Save As.

2  Type afile name for the document if necessary then click on the Save as type: 3

File name: Holland Sightseeing -

Save as type: | Word Document A
Word Document

Authars: ‘Word Macro-Enabled Document

Word 97-2003 Document
Word Template

‘Word Macro-Enabled Template
Werd 87-9N2 Tamnlata

3 Select the file format required and click on .
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Creating Folders

1 In the Open OR Save As dialog box move to the folder or position on your hard disk drive
where you require a new folder.

2 Click on Mew folder

3 Type the name of the folder in the Name box. Press Enter.

Note } A folder can be deleted by right clicking on it and selecting Delete. Al files in the folder
will also be deleted.
Changing and Moving through Drives/Folders

The Navigation Pane is used to move/change to a different folder/drive. The following actions can
be used in the Navigation Pane:

* Clicking once on a drive or folder will display its contents.

i:"_" Libraries

» Double clicking on a folder will display the contents of the folder . 4|2 Documents
and a list of any folders contained within under the folder name in 4 [&l My Documents
the Navigation Pane. An example is shown at the right. Ll E L
» 112 Exercise Files W2010
* Clicking on " at the left of a folder will display the contents of the 1 Fax
folder and a list of any folders contained within, under the folder * 1 Seanned Documents

name in the Navigation Pane, an example is shown at the right.
Clicking on the < will turn off the display of folders listed.

The Address bar at the top of the dialog box can be used to move up a folder or back to a previous
location. In the example below, files for 112 Exercise Files W2010 folder are displayed. To move
to the My Documents folder, just click on My Documents in the Address bar, or to display
Libraries, click on Libraries.

/@uv| » Libraries » Documents » My Documents » 112 Exercise Files W2010
Back

= — -

Click here to go
My Documents

To go back to a previous location click on the Back button as shown above, eg if your last location
was F drive it would go to that drive, not to the My Documents folder (one level up).

Recycle Bin

Note | If you are on a network you may not be able to use the Recycle Bin.

Right click on a blank area of the Taskbar and select Show the Desktop. Double click on the

]

Recycle Bin icon 28 on the Desktop to display all deleted files.

Files can be restored to their original folder by selecting the file(s) and clicking on Restere this item

(you can choose [Edit] Select All to select all files, then click on EMPR the RecycleBin 44 qojete a1
files.)

Delete files from the Recycle Bin from time to time. Remember that once files are deleted from
here they are gone forever!
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Storage Locations

Each organisation will have different policies for where electronic documents should be stored.
Ask your supervisor or consult your policies and procedures manual to see whether documents
should be stored in a specific folder or subfolder on the server.

You may also find there is an organisational policy relating to the printing and storage of paper-
based documents. Some “paperless” offices will encourage their staff to store documents solely in
an electronic format. Others will have a designated location for the storage of printed documents.
Printed documents should be stored in a secure, protected location as they often contain
commercially sensitive information.

Folder Structures and File Names

Use logical folder structures on a computer to ensure that files/documents can be located quickly
and easily. This allows other users to find and access files just as easily.

An example would be to have a policy that all faxes and letters are stored in the Correspondence
folder, monthly reports stored in the Reports folder etc. Businesses and organisations will have
procedures in place as to the folder structure to be used. This information is normally found in the
company’s policies and procedures manual.

Most organisations have a systematic procedure for naming files, eg all correspondence may have
the surname of the recipient, the date and the creator’s initials (Smith_20-12-11 JD). Information
on how to name your files is usually included in the company’s policies and procedures manual.

Read the scenario below and use the organisation’s policies and procedures to complete Exercise 3
on the next page.

Traim'ng One on One

You work as an assistant for a group of computer tutors and are required to perform various tasks
guided by the Organisational Policies and Procedures information below.

Organisational Policies and Procedures

Each student workstation has a folder containing exercise files stored in a folder called Exercise
Files 1onl in the default My Documents folder.

Files used for testing have the word test at the end of the file name. These need to be deleted once
a student has completed and passed an individual course.

For on-site training at a client’s location exercise files are to be copied onto a USB drive.
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Exercise 3

1  Delete the file called Formats-test.

2  Delete random files — Tables-test, Proofreading-test, Send-a-Basket-test.

3 Rename the file called Mouse to Using IntelliMouse and Suncare to Sun Protection.

4 Print all the files that begin with C.

5 Make a folder under the My Documents folder called Exercise Files lonl.

6 Copy the following files to the Exercise Files lonl folder - Italy, Jury Service, Motor
Homes.

7 Practise moving through folders and drives.

8  Copy the following files to a USB Drive - Sparkling Pools, Costello, Toastmasters.

9  Open the file called Jury Service from the Exercise Files 1onl folder, type Training One
on One at the end and then save the file in Rich Text Format. Close the file.

10 Open the file called Dining Out and save it as a Web Page. Close the file.
11 Delete the folder called Exercise Files 1onl and the files within that folder.

File Types Icon File Extension
. . @_] Microsoft Word Document .docx
There are different types of files stored on a computer. @
In Word 2010 documents are saved as files. Files in = Microsoft Word Template -dotx
Windows 7 can be identified in several ways in the Microsoft Excel Worksheet XIsx
Open or Save As dlalog boxes — #] Microsoft PowerPoint Presentation  .pptx
@—] Microsoft Access Database .accdb

e the icon displayed next to a file

e information in the Type column when Details view is selected from the Change your view
button OR Type of file information displayed in the File Properties dialog box (right click on
a file then select Properties)

o the file extension (these are the letters that are added to the end of a file name, eg Word 2010
documents have .docx added). (By default extensions are turned off in Windows 7.)

Other files you may come across when using your computer:

Executable files (ie files that start a program) .bat, .exe D % &)

Program files (dll, ini
Files with unknown file extensions L

Identifying Documents and Templates

Unit Standard 112 version 6 requires you to differentiate between a document and template file. In
the following exercise you will look at where templates are stored on your computer and how you

can identify them. As you have learnt above documents can be identified by an icon ] extension
(.docx) and by file type shown in Details view.

In Word 2010 there are three locations where templates are stored —

e Sample templates supplied with Word 2010
C:\Program Files\Microsoft Office\Templates\1033
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e Templates you create including the Normal template (ie the “default” template that is used
to display a blank document)

C:\Users\Your Name\AppData\Roaming\Microsoft

Note } This path may vary depending on the version of Windows you have installed on
your computer. The above path is for a computer with Windows 7 or Windows
Vista. A computer with Windows XP will differ, ie C:\Documents and Settings\
user name\Application Data\Microsoft\Templates

e From Word you can link to the Microsoft Templates Website -
http://office.microsoft.com/en-au/templates

Exercise 4

Note | This exercise is designed for a computer with Windows 7 installed, although notes have
been included for those running Windows Vista or Windows XP.

o]
. . : O
1 Click onmand click on = =P

2 From the Navigation Pane click on Microsoft Word (you' may need to scroll up 55y Templates
the Navigation Pane). A Templates icon will display. This is a shortcut to the ﬂd TPz
Templates folder on your computer. Double click on this folder.

Windows Vista users — click on Favorite Links, and then click on Templates.
Windows XP users — click on the Save in E and select Trusted Templates.

-

MName Date medified Type Size
Docurnent Themes 1¥11/2010 7:10 p....  File folder
LiveContent 9/11/2010 5:31 a.m.  File folder
Srartért Graphics 15/11/20101:34 p....  File folder
|E.;|!J Mormal.dotm 24/01/2011 9:25 a....  Microsoft Word M... 69 KB
|E|___!| MormalEmail.dotm 15/11/2010 1:51 p.... Microsoft Word M... 21 KB
|E|___!| MormalOld.dotm 8/11/201012:41 p.... Microsoft Word M... 16 KB

A list of templates and folders relating to your login will appear. There are two types of
templates in Word 2010 — Word Templates and Word Macro-Enabled Templates. A Word
template is a normal template used to create simple documents. More complex documents
are created using a Macro-Enabled template where macros are used to create a document.

Icon Template

4] Word Template
@) Word Macro-Enabled Template

Tip  Placing your mouse pointer over a file in the Open or Save As dialog boxes will display the
Type, Size and Date modified information.

3  The location of the Templates folder is displayed on the Address bar at the top of the Open
dialog box. Write this path name in the space below for your own information:
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http://office.microsoft.com/en-au/templates

- (M Computer

4 From the Navigation Pane double click on to display a list of the drives

installed on your computer. Double click on " & Local Disk (C) (your C drive may have a
different name, eg OS (C).)

5 Scroll down the list of folders shown in the Navigation Pane and double click on
* 1w Program Files  gero)] down and double click on ©  Microsoft Office

11033

6 Double click on * = Templates displayed in the Navigation Pane. Click on *

Sample templates are displayed to the right of the dialog box.

o o

- F &-aw - 5 LR R & -
@uvl » Computer b Local Disk(C:) » ProgramFiles » Microsoft Office » Templates » 1033 » ~ [ Search 1032 3
File Edit View Tools Help
Orgsnize Includeinlibrary v Sharewith = New folder e @
Intel 4 Name Date modified Type Size I-
> i Internet Explorer o
Access 11/02/2011 449 p....  File folder
Mcfee Security Scan -
FAX 11/02/2011 450 p.... ~ File folder L
Microsoft Analysis Services £
’ ONENOTE 11/02/2011 449 p....  File folder
4 || Microsoft Office O a o ) . )
i ] Adjacencyl etter 9/01/20109:24 p.m.  Micrasoft Word T... 203 KB
@] AdjacencyMergeLetter 9/01/20109:24 p.m.  Microsoft Word T. 207 KB u
Document Themes 14 o ) D,
i ] AdjacencyReport 9/01/20109:24 p.m.  Micrasoft Word T... 3517 KB
py ] AdjacencyResume 9/01/20109:24 .. Micrasoft Wordiis 30 K8
b
o t‘( @] ApothecaryLetter 9/01/20109:24 p.m.  Microsoft \Word Ta 166 KB
. Ta 'Ti’" ] ApothecaryMergeLetter 9/01/20109:24 p.m.  Microsoft Word(T... 189 KB
i”[;;a = ] ApothecaryNewsletter 9/01/20109:24 p.m.  Micraseft Word T4 710 kB
3
@] ApothecaryResume 9/01/20109:24 p.m.  Midfasoft Ward.T... 2238
| Presentation Designs N ) )
] BillingStatement 15/09/2006 1119 ... IMiergsoft ExcelTe.. 13 KB
Microsoft Sitverlight )
] BlackTieL etter 9/01/20109:24 p.m. | Microsaféord T... 5961 KB
> 1 MicroseftNET L ) o ) .
ves @] BlackTieMergel etter 9/01/20109:24 p.rie| Microsoft Word T... 5961 KB
b
MSX;LM] @] BlackTieNewsletter 9/01/20109:24 gum.  Migrbsaft Word T... 9,662 KB
’ ] BlackTieResume 9/01/2010 9:24 po Bpiicrosoft Word T... 5,602 KB
> | Reference Assemblies ) o
B st ] Biog 29/10/20080:02 5... | MiGtosoft Word T... 17 KB
b [F
o Some ] BloedPressureTracker 15/09/2006 958 et Microsoft Excel Te... 20KB
TechSmith A= P - e . 4 [ ive Z
I 68 items

7  Position your mouse pointer on a template. Information about the type of file, size and date
modified is displayed, an example is shown below. This is a quick way to see the file type.

@:J AdjacencyResu 9/01/201
IE-J Apothecarylett Jfj,pr: Microsoft Word Ternplate

Size: 239 KB

E:IJ ApothecaryMer =
Date modified: 9/01/2010 9:24 p.m.,
E:IJ ApothecaryNewsrerrer

TTUTIETL

8  Click on Cancel to exit the Open dialog box.

Documents are created from templates by clicking on then TV , and selecting the
appropriate template.

Sample templates stored on your computer Templates created by you

" 5 rerew viod (%)
| s Available Templates Blank document
& savess
+ Save as Adobe POF t @ Home
(5 Open
| o cose = [ ! G )
‘ g & O e You will learn how to use
s : | and create templates on
L e | 3 ‘ page 109.
print | = |
Save & Send Access  Agendas Books Business lend. Card: |
Help =
2) Options j A m =
B etfcates  Chatsand  Contacts  Ervelopes s Fyes Fomns  Inventories
’ s ’ ( 1 Templates from the Microsoft website
= : )
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Changing Defaults

Default settings may have already been changed in your Word 2010 program. If not, you can use
the following instructions to change these.

Font and Font Size

You can check if the font and font size have been changed by looking at the Font box on the Home

tab. If it shows '™"Eed "1 7 then it has not been altered. Change the default font to Arial

11 pt as follows:

1  Click on the Font Dialog Box Launcher Font which will display the Font
dialog box.

2  Change the Font: to Arial and the Size: to 11 pt.

Click on Set As Default

4 Ensure the following option is selected for the font to be applied to All documents based on
the Normal template.

Microsoft Word @

Do you want to set the default font to (Default) Arial, 11 pt for:
This document only?

@ Al documents based on the Normal template?

[ OK J I Cancel

5 Click on OK.

SpaCI ng Spacing
t: EBefore: 0 pt

Click on the Page Layout tab and if 10 pt Spacing After is displayed as shown at the = v= s 105
right then this has not been altered. Remove 10 pt spacing as follows.

1  Click on the Paragraph Dialog Box Launcher Faragraph which will display the
Paragraph dialog box. Spacing
2 Change the Spacing After: to 0 pt as shown at the right. E‘::re’ oet
After: 0pt

3 Click on [Setaseefait | £ncire Al documents based on the Normal template is
selected then click on OK.

Margins

1 Click on the Page Layout tab then click on the Page Setup Dialog Box Launcher
il which will display the Page Setup dialog box. If margins are
displayed as 3.17 cm change them as follows. (If they have been changed, click on Cancel.)

2 The Top: margin will be selected, ie ™ 3f7em =] Type: 2.54 then press the Tab
key. Repeat this until the margins are displayed as shown below.

Margins

Top: 2.54 cm - Bottom: 2.54cm —
Left: 2.54 cm - Right: 2.54cm —
Gutter: 0cm - Gutter position: Left IZ|

3 Click on L5=tAsE=faut | click on Yes.
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Formatting Text

Two examples of font and font sizes are:
Text is formatted when you want to change the style,

increase/decrease the size, colour, apply special Théo éo ?WSW 16 pt gout
effects, change alignment and spacing etc. This is Arial 14 pt font
Fonts

A font is a style of type. Fonts can be increased or decreased in size (known as point size or pt).
Windows has a variety of “OpenType” and “TrueType” fonts that will print with all printers (they

have € and ™ next to them on the drop-down list on the Home tab).

In Word it is quicker to type text, then select it and apply formatting, rather than applying formats
as you type.

To apply character formatting to a single word simply click in cursor anywhere within it and
formatting will be applied to the whole word (ie it is not necessary to select the entire word).

Once you have selected text, you can apply formatting using either —

Home tab Font Font Size Grow and Shrink Font
(increase/decrease font size)

Home Insert Page Layout References SHT

= 5 Arial 11 v |AT AT &,

=3 Copy
Paste - = o - -
« . Format Painter B 7 U-aex x| y-® -4
Clipboard F] Font

T Font Dialog Box Launcher

Font dialog box
ot =)
Font Advanced / Font

| ———— Font Size
AngsanalPC - 1
Aparajita I Italic
Arabic Typesetting —'|" | Bald

ArdleysHand Bold Ttalic

aial [

Font color: Underline style: Underline color:
Automatic E| (none) IEI Automatic ) )
Click on the Font Dialog Box Launcher
Effects
Font * | from
Strikethrough Small .
ED "bl r:rfem o gﬁa e the Home tab in the Font group to
oubie striethroug Hlcaps display the Font dialog box.
|| Superscript [ Hidden
7] subscript
Preview
Arial

This is @ TrueType font. This font will be used on both printer and screen.

set AsDefault | | TextEffects... | [ ok || cancl
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